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Support

Please visit the HP OpenView website at:

http://openview.hp.com/ 
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Chapter 1
Overview

This chapter covers the following topics:

• Introduction

• Report Types

• Ways to Customize Reports

• Options for Viewing Reports

• Sources for Additional Information

Introduction

The NNM Event Report Pack provides information on events from the nodes managed by 
NNM. You can use it to analyze trends in events and to monitor network performance. 

You can do the following activities using the report pack:

• view vendor report

• view category report

• view severity report

• view devices in the network that cause the most number of alarms 

• view the most severe alarms 

These reports help you understand the overall status of your network, identify types of 
problems and where they occur, identify reliable vendors, and decide where more resources 
must be added on the network. You can also compare the number of events in each severity 
group against expected service levels, and share this information with internal or external 
customers.

Features
The NNM Event Report Pack provides: 

• Reporting based on events collected by HP OpenView Network Node Manager by category 
and severity
7



Report Types
• Customizing the look and feel, as well as the type of data that is shown

• Customer orientation that allows customers to log in and see only relevant information 
displayed

Report Types

When you install  NNM Event Report Pack, reports are created in the NNM_Report directory. 
This directory has two child directories: Availability and Event. Reports in the Availability 
directory relate to NNM stations, Vendors, Customers and Device Type. 

The following tables displays the distribution of parameters that the reports use to filter data 
and reports under each directory. [X*] denotes that a sample report is shown at the end of this 
Guide.

The reports in the Availability subdirectory are as follows: 

The Event directory has the subdirectories such as General Reports, Category Reports, 
Severity Reports and Consolidated reports. 

The following table lists the General reports:  

Reports NNM Station Vendor Customer Device Type

Detailed Availability [X*] X X X X

Availability: Forecast by Customer X X

Availability: Forecast by Vendor X X

Availability: SLA Report [X*] X X X

Reports
NNM 
Station Vendor Customer Device

Device 
Type Category Severity

Event Summary by 
Customer

X

Event Summary by 
Device Type

X

Event Summary by 
NNM Station [X*]

X

Event Summary by 
Vendor

X

Executive Summary by 
Customer

X X X X

Executive Summary by 
Vendor [X*]

X X X X

Forecast by Category X X
8



Chapter 1
The following table lists the reports under the Category subdirectory: 

The following table lists the reports in the Severity subdirectory: 

Forecast by Severity 
[X*]

X X

Hot Spots Report X X

Hot Spots: Top 20 By 
Device [X*]

X X X

Reports
NNM 
Station Vendor Customer Device

Device 
Type Category Severity

Reports
NNM 
Station Vendor Customer Device

Device 
Type Category Severity

NNM Event Summary by 
Category and Device [X*]

X X X

NNM Event Summary by 
Category and Device Type

X X X

NNM Event Summary by 
Category and Severity

X X X

NNM Event Summary by 
Category and Vendor

X X X

Reports
NNM 
Station Vendor Customer Device

Device 
Type Category Severity

NNM Events by Severity and 
Category

X X X

NNM Events Summary by 
Severity and Device [X*]

X X X

NNM Event Summary by  
Severity and Device Type

X X X

NNM Event Summary by  
Severity and Vendor

X X X
9



Ways to Customize Reports
The following table lists the reports in the Consolidated subdirectory: 

Ways to Customize Reports

The contents of a report can be customized by applying group filters, by editing parameters, 
by editing tables and graphs, and by importing customers. If you apply a group filter, you are 
filtering out data for the purpose of creating customer-specific reports. If you edit a table, 
graph, or parameter, you are making a temporary change to a report.

Group Filters

If you intend to share your reports with customers, or want divisions within your enterprise to 
see division-specific performance data, your reports must be customer-specific, containing 
data limited to one customer. Creating customer-specific reports is an administrator task that 
involves the following steps:

• Importing custom property information (customer names and device locations) using 
Common Property Tables 3.0

• Creating a group account for all of the users affiliated with a particular customer

• Creating a group filter for the group account

For more information about creating filters for group accounts, refer to the HP OpenView 
Performance Insight 5.0 Administration Guide. 

Report Parameters

Reports use some parameters to filter data as applicable. If you edit a parameter, you are 
applying a constraint to the report with the intention of eliminating data you do not want to 
see. 

Constraining the contents of a report by editing parameters is optional and you may apply 
multiple constraints at once. NNM Report Pack has the following editable parameters: 

• Category

• Category ID

Reports
NNM 
Station Vendor Customer Device 

Device 
Type Category Severity

NNM Events by Category X X X X X X

NNM Events by Severity X X X X X X

Executive Summary by 
Category 

X X X X

Executive Summary by 
Severity [X*]

X X X X

Hot Spot Report X X X
10
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• Customer

• Customer ID

• Device

• Device Type

• NNM Station

• Severity

• Severity ID

• Vendor

To edit parameters, click the Edit Parameters icon at the bottom right-hand corner of the 
report. When the Edit Parameters window opens, type the constraint in the field and then 
click Submit.

Options for Viewing Reports

Before reports can be viewed using a Web browser, they must be deployed. Enable the Deploy 
Reports option during installation of NNM Event Report Pack. Then the reports are deployed 
and available for remote viewing. 

The method of report viewing available to you depends on how OVPI was installed. If the 
client component is installed on your system, you have access to Report Viewer, Report 
Builder, and the Management Console. If the client component was not installed on your 
system, the Web Access Server is your only option for viewing reports.

For more information about the client components, refer to the Performance Insight 
Installation Guide. For more information about deploying, viewing, and undeploying reports, 
refer to the Performance Insight Guide to Building and Viewing Reports.

Sources for Additional Information

For information regarding the latest enhancements to NNM Event Report Pack 1.0 and any 
known issues affecting this package, refer to the NNM Event Report Pack 1.0 Release 
Statement. The following documents provide additional information: 

• Common Property Tables 3.0 User Guide

• Reporting and Data Analysis with Network Node Manager

• Managing Your Network with HP OpenView Network Node Manager

The following documents are sources of information about OVPI: 

• HP OpenView Performance Insight 5.0 Administration Guide 

• HP OpenView Performance Insight 5.0 Installation Guide 

• HP OpenView Performance Insight 5.0 Guide to Building and Viewing Reports

OVPI Manuals and manuals for individual reporting solutions that run on OVPI are 
distributed with the products on the product distribution CDs. The manuals are also 
available for downloading from the following site:
11



Sources for Additional Information
http://support.openview.hp.com/support

Select Technical Support > Product Manuals to open the Product Manual Search page. Manuals for 
OVPI are listed under Performance Insight. Manuals for report packs, datapipes, and 
preprocessors are listed under Reporting and Network Solutions. 

Every title listed under Reporting and Network Solutions indicates the manual's date of 
publication. Since updated user guides are posted to this site on a regular basis, you should 
check this site for updates before using an older PDF that may not longer be current.
12



Chapter 2
The Package Installation

This chapter covers the following topics: 

• Preparing for Installation

• Installing OVPI Integration Module on NNM

• Installing NNM Event Report Pack 1.0

• Package Removal

Preparing for Installation

Before installing the NNM Event Report Pack, verify that your computer meets all the 
prerequisites for installing Network Node Manager (NNM) and HP OpenView Performance 
Insight (OVPI) on separate servers.

Prerequisites for Installation

NNM Event Report Pack 1.0 has a combination of core-product requirements and package-
level requirements. The core product requirements are as follows:

• OVPI 5.0 

• Any available OVPI 5.0 Service Pack 

• NNM OVPI Integration Module

The package-level prerequisites are as follows: 

• Common Property Tables 3.0 

You will find information about each Service Pack, including installation instructions, in the 
release notes for the Service Pack.

NNM and OVPI should be in the same time zone.
13



Installing OVPI Integration Module on NNM
Distributed Environments

If you are running NNM Event Report Pack on a distributed system, the central server, every 
satellite server, and every remote poller must be running OVPI 5.0 and with available Service 
Packs.

Before Installing NNM Event Report Pack, you must verify that the Network Node Manager 
(NNM) services are operating on the management station. 

Installing OVPI Integration Module on NNM

To verify that NNM services are operating on the management station, follow these steps.

Make sure on Windows, Perl shipped with NNM is in the PATH.

1 Execute ovstatus -v to verify that NNM is installed and running.

All of the processes, including pmd, should be running. Refer to the HP OpenView 
Network Node Manager Quick Start Installation Guide for instructions on how to install 
the NNM product.

2 Insert the RNS 5.0 CD and start the Installer. 

Windows: Run setup.bat  

UNIX: Run setup 

3 Source OV NNM environment variables:

Windows: Source.%OV_BIN%\ov.envvars.bat into Windows environment.

UNIX:  If running sh or ksh on HP-UX or Solaris, source . /opt/OV/bin/ov.envvars.sh 
into UNIX environment.

If running csh on HP-UX or Solaris, source /opt/OV/bin/ov.envvars.csh into UNIX 
environment.

4 Install the NNM OVPI Integration Module (if not already installed).

a Insert the RNS 5.0 CD and select 2 from the Reporting and Network Solutions 5.0 
Main Menu.

b Select 2 from the NNM Value-add Components Menu. Messages about NNM such as 
version and installation are listed. 

c Enter the address of the system running the OVPI Report Application Server. 
Example: ovpi.testhp.com

d Enter the port number that the OVPI Report Application Server is running on. 
Example: 80

e Select 0 from the Reporting and Network Solutions 5.0 Main Menu.

f Select 0 again to complete installation and Exit. 
14



Chapter 2
5 Start the ICO_RNS service on Windows. This step is not required on UNIX.

Installing NNM Event Report Pack 1.0

Perform the following tasks to install NNM Event Report Pack 1.0: 

• Task 1: Extract packages from the product distribution CD

• Task 2: If necessary, upgrade Common Property Tables

• Task 3: Install NNM Event Report Pack 1.0

Task 1: Extracting Packages from the RNS 5.0 CD

Follow these steps to copy OVPI packages from the Reporting and Network Solutions CD to 
the Packages directory on your system:

1 Log in to the system. On UNIX systems, log in as root.

2 Stop OVPI Timer and wait for processes to terminate.

Windows: Select Control Panel  > Administrative Tools > Services

UNIX: As root, do one of the following:

HP-UX: sh /sbin/ovpi_timer stop

Sun: sh /etc/init.d/ovpi_timer stop

3 Insert the RNS 5.0 CD. Do one of the following:

• On Windows, run the setup.bat command if auto run is disabled. If outrun is 
enabled, a Main Menu appears. 

• On UNIX, mount the CD manually if the CD does not mount automatically, then run 
the setup command.

4 Type 1 to select OVPI report packs in the choice field and press Enter. The install script 
displays a percentage complete bar. When extraction is complete, the install script starts 
Package Manager. The Package Manager Welcome window opens.

You can navigate to the Packages directory on your system to see the following directories 
under the NNM Event Report Pack directory:

• NNM_Event.ap

• NNM_Event_Demo.ap

Installing the demo package is optional. You may install the demo package by itself, or you 
may install the demo package along with the other packages. Selection tables are linked 
to graphs and you may experiment with view options for individual tables and graphs. 

When you install NNM/OVPI Integration Utilities, a Windows service called 
ICO_RNS is installed. To move event data from NNM to OVPI, this service 
must be running. Though the installation process creates the server and sets 
its start status to automatic, it does not actually start the service.

You must manually start the service the first time. After this, whenever the 
machine is restarted, this process is also restarted automatically.
15



Installing NNM Event Report Pack 1.0
Task 2: Upgrade Common Property Tables 

If you are running an older version of Common Property Tables, you must first upgrade to 
Common Property Tables 3.0. Installing this particular upgrade package is no different from 
installing other upgrade packages; however, keep in mind that you cannot install the upgrade 
for Common Property Tables and other packages at the same time. Finish the upgrade for 
Common Property Tables first, then run the install wizard a second time to install the other 
packages. 

Task 3: Installing NNM Event Report Pack 1.0

If Package Manger is not running, select Package Manager from the Management Console 
and follow these steps.

1 Click Next. The Package Location window opens.

2 Click the Install radio button.

3 Approve the default installation directory or use the browse feature to select a different 
directory, if necessary. 

4 Click Next. The Report Deployment window opens.

5 Accept the default settings for Deploy Reports; also accept the defaults for application 
server name and port in the same window. 

6 Enter trendadm as username and password. 

7 Click Next. The Package Selection window opens. 

8 Select the check box next to the following package names:

CommonPropertyTables 3.0 

NNM_Event 1.0 

NNM_Event_Demo 1.0 

9 Click Next. The Type Discovery window opens. 

10 To run Type Discovery immediately after package installation, unselect Type Discovery 
and click Next.

11 The Selection Summary window opens; verify if the contents of this window are correct.

12 Click Install to begin the installation process. The Installation Progress window opens and 
the install process begins. When the install process is complete, an installation complete  
message appears. 

13 Click Done to return to the Management Console. 

14 Restart OVPI Timer.

For information on how to Configure NNM Event Report Pack, see Chapter 3, NNM Event 
Report Pack Configuration.
16
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Package Removal 

Follow these steps to uninstall NNM Event Report Pack 1.0:

1 Log in to the system. On UNIX systems, log in as trendadm.

2 Stop OVPI Timer and wait for processes to terminate.

3 Launch Package Manager. The Package Manager welcome window opens.

4 Click Next. The Package Location window opens.

5 Click the Uninstall radio button.

6 Click Next. The Report Undeployment window opens.

7 If NNM Event Report Pack reports were deployed from this server, accept the defaults for 
Undeploy Reports, Application Server Name, and Port. Otherwise, clear the check box and 
skip to step 9.

8 Type the username and password as trendadm.

9 Click Next. The Package Selection window opens.

10 Click the check box next to the following packages:

NNM_Event 1.0 

NNM_Event_Demo 1.0  

11 Click OK.

12 Click Next. The Selection Summary window opens. 

13 Click Uninstall. The Progress window opens and the removal process begins. When the 
uninstall process is complete, a package removal complete message appears. 

14 Click Done to return to the Management Console.

15 Restart OVPI Timer.

If you remove a report pack, the associated tables and all the data in those 
tables will be deleted. If you want to preserve the data in those tables, archive 
the data before removing the report pack.
17
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Chapter 3
NNM Event Report Pack Configuration

This chapter covers the following topics: 

• Provisioning NNM Management Station

• Adding and Modifying Properties

• Configuring Servers in a Distributed System

Provisioning NNM Management Station

A list of NNM stations is required to collect the event and availability data. There are two 
ways to provision the NNM list. One is to use OVPI forms, as described in “Using Forms on 
page 21” and the alternative method is to use Bulk Import. 

Bulk Import

To import, a list of NNM Stations use Bulk Import which involves the following tasks.

• Task 1: Creating the NNM station list file

• Task 2: Importing the NNM station list file

Task 1:  Creating the NNM stations list file

Create a property parameter file NNM_List.dat in the directory $DPIPE_HOME/data/
PropertyData/NNM_Event/ when bulk import of NNM stations is to be done or a set of 
NNM stations for collection is required. To import one NNM station, use forms as described in 
Using Forms on page 21

Format of the data is as follows:

<nnm_station_1><tab><ovi_port_number>

<nnm_station_n-1><tab><ovi_port_number>

<nnm_station_n><tab><ovi_port_number>

Example:

nnm1.hp.com  8092
19



Adding and Modifying Properties
nnm2.hp.com  8092

nnmn.hp.com  8092

The default OVI port number is 8092. 

Task 2: Importing the NNM stations list

To import the NNM Station list, run the NNM List Importer tool

$DPIPE_HOME/bin/trend_proc -f $DPIPE_HOME/scripts/NNM_Event_import_nnm.pro

The tool imports the NNM_List.dat to the OVPI database. The imported list is now ready for 
data collection. 

Data Collection

Once the NNM Stations list is provisioned, the system is ready for collection. During the first 
collection, the data collection tool will automatically:

1 Get the nodes from NNM with Device Type, Vendor and Category information. 

2 Get data for the last two days from the NNM Station or as available in NNM, whichever is 
lower. 

3 Put the category list into OVPI.

Adding and Modifying Properties

Reports use the following parameters to filter data as applicable. An alphabetical list of 
properties that  can appear in reports is shown below: 

• Category

• Category ID

• Customer

• Customer ID

• Device

• Device Type

• NNM Station

• Severity

• Severity ID

Change this port number only if you have changed the port number for the 
CommandResponder pluglet of OVI.

Errors are logged in the $DPIPE_HOME/log/trend.log. 

By default, the data collection is done every 1 hour. The data aggregated by 
NNM is at the periodicity (polling granularity) of 15 minutes.
20
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• Vendor

Property information comes from the following sources:

• Common Property Tables batch-mode property import

• Common Property Tables (Device, Customer, Vendor)

• Category List Table

• NNM List Table

• NNM List Tables “add new” and “update” forms 

• Category List Table “add new” and “update” forms 

• Automatic feed from the network

If you have customers associated with specific devices or specific interfaces, or if you have 
vendors associated with specific devices, use Common Property Tables to import this 
information.

Using Forms

This section discusses the following forms:

• Add or Update NNM List

• Remove NNM Station

• Add or Update Category Information

• Remove Alarm Category

• Update Availability Threshold

These forms are used to create, update or remove property data. Forms are available with 
OVPI 5.0. To launch a form, click the Objects icon in the panel on the left side of the 
Management Console window.

The Object/Property Management view opens. Object Manager shows a list of objects. The 
type of object presented depends on which Object Manager View is open. The default view is 
the Device view, showing a list of devices. To change the view, select View > Change View and 
use the pop-up window to select a different view. Once the type of object you are interested in 
updating is displayed, select the particular object you would like to update. When you select 
the object, Object Specific Tasks will appear in the window on the right. Double-click and open 
the form. Click Apply to save changes, OK to save changes and close the form, or Cancel to close 
the form without saving changes.

Add or Update NNM List 

You can use the Add or Update NNM list form to add or update an NNM station for OVPI to 
collect data. This form lists the collection or polling interval and polling granularity.

To update an NNM station, do as follows:

1 Launch the Management Console (piadmin).

2 Click the Objects icon, and under General Tasks window  the Add or Update NNM list 
form will appear in the window on the right. Navigate to the NNM station you want to 
update, and double-click the Add or Update NNM list form.
21



Adding and Modifying Properties
3 Highlight the row that contains the data you want to change.

4 If required, change the Polling Granularity and then change the following entry in the 
$DPIPE_HOME/trendtimer.sched:

01:00 - - {DPIPE_HOME}/bin/trend_proc -f {DPIPE_HOME}/scripts/NNM_Event.pro

For example, if Polling Interval is 180 mins, then change the entry as shown below:  

03:00- - {DPIPE_HOME}/bin/trend_proc -f {DPIPE_HOME}/scripts/NNM_Event.pro

Polling Granularity is the result of duration units divided by Polling Interval. For a given 
Polling Interval, events data collected can be aggregated over smaller units of duration 
(called Polling Granularity). For example, if Polling Interval is 60 mins, then Polling 
Granularity can have values such as 30, 60, and 180 mins.

5 Make the changes. Click Apply to save changes, OK to save changes and close the form, or 
Cancel to close the form without saving changes.

To add a new NNM station, do as follows: 

1 Select any row. 

2 Enter the name of the NNM station in the NNM Station field. Change other values as 
required.

3 Click Apply to save changes, OK to save changes and close the form, or Cancel to close the 
form without saving changes.
22
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Remove NNM Station 

To remove a single NNM station, do as follows:

1 Launch the Management Console (piadmin).

2 Open the  Object/Property Management view and select View > Change View and use the 
pop-up window to select OV NNM view. The NNM stations are listed here. 

3 Select the NNM station you want to remove. 

4 Double-click the Remove NNM Stations form from the Object Specific Tasks window. The 
form opens.

The form displays the NNM station configured for OVPI data collection. 

5 Highlight the row that contains the NNM station that you want to remove. 

Once you remove an NNM station, that NNM station will stop 
collecting data. But if there is any existing data, that will still be 
available. 
23



Adding and Modifying Properties
6 Click Apply to remove the NNM station, OK to save changes and close the form, or Cancel 
to close the form without saving changes.

Add or Update Category Information

To update a new alarm category for an NNM station, do as follows:

1 Launch the Management Console (piadmin).

2 Click Objects, and under General Tasks window, the  Add or Update Category Information 
form will appear in the window on the right. 

The form displays the category based on the selected NNM station, in a tabular format. 

3 Highlight the row that contains the data you want to change. 

4 Make the changes. Click Apply to save changes, OK to save changes and close the form, or 
Cancel to close the form without saving changes. 

To add a new NNM station, do as follows: 

1 Select any row. 

2 Enter the new Category Id and Category Name.
24
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3 Click Apply to save changes, OK to save changes and close the form, or Cancel to close the 
form without saving changes.

Remove Alarm Category

To remove a category for an NNM station, do as follows:

1 Launch the Management Console (piadmin).

2 Open the  Object/Property Management view and select View > Change View and use the 
pop-up window to select OV NNM view. The NNM stations are listed here. 

3 Select the NNM station that you want to remove. 

4 Double-click the Remove Alarm Category form from the Object Specific Tasks window. The 
form opens.

The forms displays the list of NNM stations and their Category list.

5 Highlight the row that contains the NNM station, Category Id and Category Name that 
you want to remove. 

6 Click Apply to remove a category for an NNM station, OK to save changes and close the 
form, or Cancel to close the form without saving changes.
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Update Availability Threshold

The Availability Threshold (percentage of availability) values are based on NNM station, 
Customer, Vendor and Device type. Threshold is the line between normal and abnormal 
performance. When this line is crossed, an exception is recorded. Thresholds are set to default 
values that are easily changed to reflect individual needs.

To change the threshold value, do as follows:

1 Launch the Management Console (piadmin).

2 Click Objects, and under General Tasks window,  the Update Availability Threshold form 
will appear in the window on the right. Double-click the Update Availability Threshold 
form to open it.

The form displays a table listing the NNM stations, Customer, Vendor, Device Type and 
the Availability Thresholds. 

3 Highlight the row that contains the Availability Threshold, which you want to change.
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4 Make the changes. Click Apply to save changes, OK to save changes and close the form, or 
Cancel to close the form without saving changes.

Configuring Servers in a Distributed System

If your system is distributed, and you installed NNM Event Report Pack, you must configure 
the central server and each satellite server. 

Central Server

To configure the central server, perform the following tasks:

• Task 1: Set up connections with satellite server databases

• Task 2: Configure trendcopy pull commands and modify the entry in trendtimer.sched.

Task 1: Set up connections with satellite server databases

1 Start the Management Console.

2 Click the Systems icon on the lower left. The System/Network Administration pane opens.
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3 Right-click the Databases folder. When prompted, select Add OVPI Database. The Add 
Database Wizard opens. 

4 Click Next.

5 Type the hostname and port number for the database you want to add; click Next.

6 Review the Summary. Repeat Steps 4 and 5 for each additional database.

7 Click Finish when you are done. 

Task 2: Configure trendcopy pull commands and modify the entry in trendtimer.sched

1 Open the following files:

$DPIPE_HOME/scripts/hourly_NNM_Event.pro

$DPIPE_HOME/scripts/hourly_NNM_Avail.pro

2 Modify the trendcopy commands so that each command includes the correct server name 
for each satellite server.

3 If necessary, add more commands.

4 Optional. If the installation requires rate data to be available on the central server, 
change SH_NNM_Event, SH_NNM_Avail in copy commands to RNNM_Event, 
RNNM_Avail. 

5 The NNM_Event.pro calls the hourly process file to collect both Event and Availability 
summarizations. Edit the file $DPIPE_HOME/lib/trendtimer.sched. To ensure that 
the satellite server completes hourly summarizations before the central server does the 
same,  Change the trendtimer start time from 1:00 to 1:00+20. By default, this process 
starts at beginning of every hour.

6 Ensure that all system clocks are synchronized. This is critical in a distributed 
environment in which linked processes run on different machines. If the system clocks are 
not synchronized, the sequence of executing these processes will be inaccurate.

Satellite Server

Follow these steps to configure a satellite server.

1 Switch off the following aggregations by commenting out the entries listed below, from the 
$DPIPE_HOME/lib/trendtimer.sched file:

24:00+03:00 - - {DPIPE_HOME}/bin/trend_proc -f {DPIPE_HOME}/scripts/
daily_NNM_Event.pro

24:00+03:00 - - {DPIPE_HOME}/bin/trend_proc -f {DPIPE_HOME}/scripts/
daily_NNM_Avail.pro

SU+24:00 - - {DPIPE_HOME}/bin/trend_proc -f {DPIPE_HOME}/scripts/
weekly_NNM_Event.pro

MONTH1+24:00 - - {DPIPE_HOME}/bin/trend_proc -f {DPIPE_HOME}/scripts/
monthly_NNM_Event.pro

If you copy polled rate data from each satellite server every hour, you will 
increase the amount of traffic between the satellites and the central server 
and you will increase the processing load on the central server.
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MONTH1+24:00 - - {DPIPE_HOME}/bin/trend_proc -f {DPIPE_HOME}/scripts/
monthly_NNM_Avail.pro

MONTH1+24:00 - - {DPIPE_HOME}/bin/trend_proc -f {DPIPE_HOME}/scripts/
yearly_NNM_Avail.pro

2 Modify the hourly_NNM_Event.pro, by commenting out all entries except the following 
summarization:

{DPIPE_HOME}/bin/trend_sum -f {DPIPE_HOME}/scripts/hourly_NNM_Event.sum

3 Make sure that each satellite server is collecting data from a disjoint set of NNM Stations.

Other Configurations

You may want to edit other configurations to change the port number or synchronize node 
information or category information.

Changing the HTTP Port Number of OVI on NNM

If the port number 8092 is already in use, do the following to change the port number:

1 On NNM, change the <serverPort>8092</serverPort> parameter in the file specified 
below to identify the new HTTP port number.

UNIX

$OV_INSTALL_DIR/conf/OVPI_INTEGRATION/ResponderProxyPluglet.config 

Windows

$OV_INSTALL_DIR/newconfig/OVPI_INTEGRATION/ResponderProxyPluglet.config

2 Re-start the OVI CommandResponder pluglet. To start or stop OVI, do as follows:

UNIX

$OV_BIN/ICO_ctl.ovpl -s : to stop OVI

$OV_BIN/ICO_ctl.ovpl -g : to start OVI

Windows

%OV_BIN%\ICO_ctl.ovpl -s : to stop OVI

%OV_BIN%\ICO_ctl.ovpl -g : to start OVI

To Synchronize the Node Information or Category Information

Use the get_nnm_aggevt tool to synchronize the node information or category information 
from all the NNM Stations. 

• To update NNM Event report pack with current node information from NNM, use the 
following script to get the node information:

$DPIPE_HOME/bin/perl $DPIPE_HOME/scripts/get_nnm_aggevt.pl -i

• The alarm category can increase overtime. (Example: If you install new RNS SPI’s) To 
update NNM Event report pack use the following script to get the node information:

  $DPIPE_HOME/bin/perl $DPIPE_HOME/scripts/get_nnm_aggevt.pl -c
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Configuring HTTP Timeout on OVPI for OVI Communication

To overcome HTTP timeout on OVPI, use Add or Update NNM List form and update the 
HTTP Timeout field. Make the changes. Click Apply to save changes, OK to save changes and 
close the form, or Cancel to close the form without saving changes.

Changing OV NNM Events Data Tool

OV NNM provides Events data using the following tools:

• ovdumpevents: This is the default data collection tool on OVPI. 

• ovdwquery: This is based on RDBMS. 

For more information on these tools, refer to the HP OpenView Network Node Manager 
Managing Your Network with HP OpenView Network Node Manager. 

To change the tool to ovdwquery, do as follows:

1 Access the $DPIPE_HOME/lib directory

2 Create a configuration file named NNM_Event_Report.conf with the following entry:

AGG_TOOL,ovdwquery

The tool will now be used in the next poll cycle, to get events data from OV NNM.

To change the tool to ovdumpevents, do as follows:

1 Access the $DPIPE_HOME/lib directory

2 Do one of the following:

• remove the conf file NNM_Event_Report.conf 

• modify the AGG_TOOL entry in the above configuration file as  
AGG_TOOL,ovdumpevents

Checking Collection Failures

Check the following log files in sequence:

1 On OVPI, the collection details for all the NNM Stations are logged in $DPIPE_HOME/
log/trend.log. Check for entries with get_nnm_aggevt.pl, the module that collects 
events data from NNM Stations.

2 On NNM, the collection details and failures, if any, are logged in 

$OV_TMP/OVPI/NNM_EVT_RP_*log
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NNM Event Reports

This chapter covers the following topics:

• NNM Event Reports

• Availability Reports

• Event Reports

NNM Event Reports

The NNM Event Report pack provides a summary of event data collected from NNM stations 
based on the following parameters:

• Category

• Severity

• Device

• Device Type

• Vendor 

• Customer

This chapter provides a brief description and screen shots for some of the Availability and 
Event reports. Sample reports are shown to illustrate the different report formats.

Description of terms used in the reports:

mtbf  (mean time between failure) mean time between failure for selected vendor and 
device type

mttr (mean time to repair ) mean time to repair for selected vendor and device type

availability availability for selected vendor and device type

downtime downtime for selected vendor and device type
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Availability Reports

You can use the following Availability Reports to check the availability of network devices: 

• Detailed Availability Report: This provides mttr, mtbf, availability and downtime of nodes 
managed by NNM. 

• Forecast by Customer: This provides 30, 60 and 90 days' forecast on mttr, mtbf and 
downtime.

• Forecast by Vendor: This provides 30, 60 and 90 days' forecast on mttr, mtbf and 
downtime.

• SLA Report: This provides information on the availability, downtime (with threshold 
values of availability breaches) for vendors and customers.

Detailed Availability Report

You can use the Detailed Availability report to view reports on the statistics and the availability 
metrics.

To view availability metrics: 

1 Open the report and select the NNM station.

2 Select the customer. 

3 Select the vendor. 

4 Select the device type. 

The reports display the statistics based on month to date, monthly and yearly availability 
metrics:

• Month to date — This displays the statistics on a daily basis for this month.

• Monthly — This displays the summary of statistics on a monthly basis for the last 6 
months.

• Yearly — This displays the summary of statistics for the last 3 years.
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Forecast by Customer

You can use the Availability: Forecast by Customer report to view the mtbf, mttr, availability, 
and downtime. 

To view the summary forecast:

1 Open the Availability: Forecast by Customer report. 

2 Select the customer and device type from the respective table in the report. The report 
displays the following: 

• MTBF: This shows the mean time between failure for selected vendor and device type.

• MTTR: This shows the mean repair time for the selected vendor and device type.

• Availability: This shows the availability for the selected vendor and device type.

• Downtime: This shows the downtime for selected vendor and device type.
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SLA Report

You can use the Availability SLA Report to view the availability with threshold and total 
downtime based on vendor and device type or customer and device type. 

To view the summary of availability with threshold breach and downtime: 

1 Select the vendor and do one of the following:

• Select the device type.

• Select the customer and device type from the from the respective table in the report.

2 Select a specific time period. This could be a day or a month. The availability and 
downtime details appear as follows:

• Daily Availability: This shows the availability and availability threshold for the 
last seven days.

• Monthly Availability: This shows the availability and availability threshold for 
the previous months.

• Daily Downtime: This shows the total downtime for the last seven days.

• Monthly Downtime: This shows the total downtime for the last six months.
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Event Reports

Reports in the Event directory are organized in the following sub-directories:  

• General 

• Consolidated
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• Category 

• Severity  

An Event Report includes information on the Event, Executive Summary by Customer, Device 
Type, NNM Station, and Vendor. You can analyze events in each severity group by comparing 
the numbers against expected service levels. This analysis could be useful for your internal or 
external customers.

Executive Summary by Vendor

This is a General report available under the Events directory. The Executive Summary by 
Customer report is similar to this report.

You can use the Executive Summary by NNM Vendor report to view the Event Count based on 
vendors of the devices managed by all NNM stations. 

To view the summary for a specific vendor:

1 Open the Executive Summary by NNM Vendor report.

2 Select the vendor from the respective table in the report. The summary displays the 
Executive Summary Count as follows: 

• Daily: This shows the daily summary statistics for the last seven days.

• Weekly: This shows the weekly summary for the last four weeks.

• Monthly: This shows the monthly summary for the last six months.
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Event Summary by NNM Station

This report is a General report available under the Events directory. Other reports similar to 
this report are:

• Event Summary by Vendor

• Event Summary by Customer

• Event Summary by Device

You can use the Event Summary by NNM Station report to view the Event Count based on the 
currently managed NNM stations. 

To view the Event Count for a specific NNM station:

1 Open the Event Summary by NNM Station report.

2 Select the NNM station from the respective table in the report. The summary displays the 
Event Count as follows: 

• Daily: This provides the daily statistics for the last seven days
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• Weekly: This provides the weekly statistics for the last four weeks 

• Monthly: This provides the monthly statistics for the last six months

Forecast by Severity

This  is a General report available under the Events directory. The Forecast by Category is 
similar to this report.

You can use the Forecast by Severity report to view the forecast of total events for 30, 60 and 90 
days. 

To view the report: 

1 Open the Forecast by Severity report. 

2 Select the NNM Station and the Severity from the respective table in the report. 

The total events appear as a graph along with the baseline data.  The baseline event count 
is the weighted average. The summary displays the Event Count as Baseline data versus 
number of days of forecast.
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Hot Spots Report: Top 20

This  is a General report available under the Events directory. The Hot Spots report is similar 
to this report.

You can use the Hot Spots Report: Top 20 report to view the list of top 20 devices generating the 
most severe events. These events are aggregated on a daily and weekly basis. 

To view the summary for a specific device:

1 Open the Hot Spots Report: Top 20 report.

2 Select a device listed under NNM station. 

3  Select the severity type.

The report shows the Top 20 devices that generate most events in the following time ranges:

• Daily:  This shows the daily statistics for the previous day

• Weekly: This shows the weekly statistics for the previous week 
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NNM Events Summary by Category and Device

This report is available under the Category directory. Other reports located in the directory 
are:

• NNM Events Summary by Category and Device Type

• NNM Events Summary by Category and Severity

• NNM Events Summary by Category and Vendor

You can use the NNM Events by Category and Device report to view the Event Count based on 
category and device. 

To view the Event Count by Device for a specific NNM station and Category:

1 Open the NNM Events by Category and Device report.

2 Select the NNM station and Category from the table located at the top of the report. The 
summary displays the Event Count as follows: 

• Daily: This provides the daily statistics for the previous day.

• Weekly: This provides the weekly statistics for the previous week. 

• Monthly: This provides the monthly statistics for the previous month.
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NNM Events by Severity and Device

This report is available under the Severity directory. Other reports located in the directory are:

• NNM Events by Severity and Category

• NNM Event Summary by Severity and Device Type

• NNM Event Summary by Severity and Vendor

You can use the NNM Events by Severity and Device report to view monthly Event Count based 
on severity and device. The report provides  the list of event count by device aggregated over 
monthly, weekly and daily statistics.

To view the Event Count by Device for a specific NNM station and Severity:

1 Open the NNM Events by Severity and Device report.

2 Select the NNM station and Severity from the respective table in the report. The 
summary displays the Event Count as follows: 

• Daily: This provides the daily statistics for the previous day

• Weekly: This provides the weekly statistics for the last week 

• Monthly: This provides the monthly statistics for the last month
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Executive Summary by Severity

This report is available under the Consolidated directory. Other reports located in the 
directory are as follows:

• Executive Summary by Category

• Executive Summary by Severity (see sample report)

• Hot Spot Report

• NNM Events by Category

• NNM Events by Severity 

You can use the Executive Summary By Severity report to view monthly Event Count based on 
vendor and customer. The report provides 30, 60 and 90 days' forecast on the total events 
computed using the weighted average of total events aggregated by Severity. 

To view the summary for a specific NNM station:

1 Open the Executive Summary By Severity report.

2 Select the NNM station from the table located at the top of the report. You can also select 
Vendor and Customer. The summary displays the Event Count as follows: 

• Daily: This provides the daily statistics for the previous day
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• Weekly: This provides the weekly statistics for the previous week 

• Monthly: This provides the monthly statistics for the last six month
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